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Welcome to the third edition of the Office Professional Newsletter. The objective of this 
publication is to provide students, graduates, and community members updated 
information about the Office Professional and General Business programs at Panola College. 
If you like the newsletter or have suggestions for improving it, email us and let us know. 

Marketing Course Pilots Canvas 

You may have noticed that 
some of your online 
courses at Panola College 
are now being offered in 
Canvas, a new Learning 
Management System (LMS) 
that is being piloted by the 
college. For the past 
decade, the college has 
been using WebCT as the primary delivery application for online courses. 
Recently WebCT was purchased by BlackBoard and support for the 
product will eventually be phased out. Consequently, Panola College has 
been searching for an appropriate alternative that will be beneficial for 
both faculty and students. 

The General Business faculty offered offer MRKG 1311 – Principles of 
Marketing using the new LMS in Spring 2011. As the name implies, Canvas 
provides instructors a palette of tools for creating course content. For 
example, the marketing course uses a significant number of YouTube 
videos to teach marketing concepts. Canvas easily incorporates video into 
the online assignments and students seem to like the interface. Instructors 
love to give feedback on assignments. When assignments are graded in 
Canvas, the instructor has the opportunity to provide feedback directly on 
the assignment itself and students can ask questions on the assignment 
page as well—the entire conversation between the instructor and student 
is recorded directly on the assignment. In addition, Canvas gives students 
a variety of ways to interact with their instructors and the course itself. 
Due dates for assignments can be sent directly to a student’s email, 
phone, or Facebook account. 

If you are taking a class using Canvas this semester, you can learn how to 
use the new LMS by attending a training session on August 22 or 23 from 
2-4 p.m. 
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What’s New in Office 2010? 

You may remember that the move from Office 2003 to Office 2007 a few 
years ago was a big jump visually. The visual appearance and functionality 
of the interface was completely different. For those of you who upgraded 
to Office 2007, you’ll be pleased with some of the changes Microsoft has 
made to the Office 2010 product. For those of you who missed the move 
last time, now is the time to get on board. 

Here are a few things we think you will like: 

 File tab or Backstage view – Remember the old File menu? Most 
applications still make use of a File menu, but Office 2007 abandoned it for 
the Office Button. You’ll be happy to know that a File tab has replaced the 
Office Button on the ribbon in Office 2010. When you click the File tab, the 
application opens what Microsoft calls the Backstage view. All of the familiar 
commands are available such as Save, Save As, Close, and Print. However, it 
also displays an information panel that gives you a preview of the file and 

Microsoft Office 2010 on 
Campus 
 

If you are a Microsoft Office user, 
you may have heard that a new 
version of the software is on the 
market. Microsoft Office 2010 is 
now being taught in all of Panola 
College’s application software 
classes. If you are looking for an 
introduction to each of the 
software applications, consider 
taking BCIS 1305. If you would like 
an in-depth study of Word, Excel, 
PowerPoint, or Access, there are 
semester-length classes available 
online and the classroom for each 
one. 

 

This is a fantastic time to be entering the business world, because business is going to 
change more in the next 10 years than it has in the last 50. 
 Bill Gates –Microsoft 
 

What is a marketable 
skills certificate? 
 

Ever feel lost in Word or 
Excel?  We understand. It’s 
difficult to move to a new 
piece of software—especially 
when you are fairly satisfied 
with what you are using 
currently. The Marketable 
Skills Certificate gives current 
students as well as working 
professionals the chance to 
learn Word, Excel, and Access 
either in the classroom or 
online. Students taking all 
three classes either for credit 
or continuing education will 
be awarded a certificate. For 
more information about 
acquiring a  marketable skills 
certificate, contact Dwayne 
Ferguson @ 903.693.2066 for 
more information. 

provides all of the details about the open document. The new tab means a 
much more logical and familiar feel for users of previous versions. 

 Updated Print Tool – When 
you click the File tab and 
Print, you will see all of your 
print options on one screen, 
not in a dialog box. This view 
provides a large preview of 
the document and the ability 
to scroll through the pages of 
the document right there on 
the Print screen. A big 
advantage to the design of this screen is that you can change things like 
orientation (portrait or landscape) right there in Print. The changes that you 
make on the Print screen actually take place in the document. 

 Paste Options Live Preview – When you copy and paste text, you have 
probably noticed the Paste Options button appear and basically ask you to 
pick the formatting—from the source, from the destination, or just plain 
text. You still have those familiar buttons, but now you will see the text 
change on the screen as you point to an option. 

 Screenshots – Have you ever needed a screen shot (a copy of the screen you 
are working on) to insert into an email or into a document you are 
preparing? You can still use the Print Screen key to copy a screen and then 
paste it into a document. However, Microsoft has now included a Screen 

Shots tool on the Insert tab. When you click the drop-down arrow on 
the tool, you will see all of your open applications and you can choose 
which screen to copy. 
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The Ultimate Steal 
by Dwayne Ferguson, Office Professional/General Business Instructor 

Everybody likes a good deal, right? 

Have you heard about “The Ultimate Steal”? If not, just Google it. While this 
deal is not free, it is well worth the time to check it out. 

If you are looking for a good 
productivity software package 
with a word processor, 
spreadsheets package, database 
management system, and 
presentations package, look no 
further. Microsoft is making their 
Office Professional Academic 
2010 suite available to students 
for just $99.95. Compare that to 
$500 which is what the professional version sells for at most retailers.   

The professional version contains the following products: 

 Word – A document processing application that can be used to create 
professional letters, memos, reports, legal and medical documents, 
agendas, minutes, and so much more. Word 2010 is required for the word 
processing and keyboarding classes. It is also useful for creating reports 
for numerous classes on campus. 

 Excel – A spreadsheets application that uses formulas and charts to 
illustrate sales, inventory, payroll, time sheets, etc. Obviously, Excel 2010 
is required for the spreadsheets classes. It might also be helpful in any 
class that involves using formulas such as a math or accounting class.   

 PowerPoint – A presentation application used to share ideas with others 
in a classroom setting or a meeting. Students will learn PowerPoint in 
ITSW 1410 – Intro to Presentation Graphics Software. In addition, you 
may be asked to create a presentation in a speech or history class. 

 Outlook – An email application that allows you to contact friends or 
clients. 

 OneNote – Planning and note taking software. 

 Publisher – Desktop publishing application used to create flyers, 
brochures, calendars, etc. 

 Access – A database application that allows you to manage data and 
create forms, tables, queries, etc. 

If you are an Office Professional, General Business, or Computer Information 
Technology major, this productivity software package will be all you need for 
the two years you are here on campus. 

To purchase the software, you can email Microsoft from the Web site or call 
1-877-696-7786. You will have to provide proof that you are a student and 
they will ask you for your Panola College email address. 

 
 
 

Cloud Computing with 
Windows SkyDrive 

Everybody’s talking about 
cloud computing, but what 
does it mean? 

Cloud computing is a way 
for IT professionals to 
provide on-demand 
network or application 
services to users without 
having to invest in 
infrastructure. What does 
that mean for you? Well, 
Microsoft’s newest entry 
into cloud computing is 
SkyDrive and best of all it’s 
free. All you have to do is go 
to www.live.com and 
register. SkyDrive provides 
you with 25 GB of free 
storage space where you 
can save your documents 
and photos. Stored files can 
be access from anywhere 
you have an Internet 
connection and can be 
shared with whoever you 
want. In addition, SkyDrive 
offers everyone the use of 
free Microsoft Office 
applications such as Word, 
Excel, and PowerPoint. 

If you need extra storage 
space but don’t want to 
spend the extra cash, try 
SkyDrive. 
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Spring 2011 Graduating Class 

The Office Professional and General Business programs awarded 37 degrees 
and certificates this past fall and spring. Here are some of our recent 
graduates. 

   
Gardine Bolden 
Major: Office Professional 
Award: Office Professional AAS 
Employer: District Attorney’s 
Office in Mansfield, Louisiana 

Bonnie McKnight 
Major: Office Professional 
Award: General Office Certificate  
Employer: Panola College 
Marshall Center 

Cynthia Perfecto 
Major: Office Professional 
Award: Office Professional – 
Medical Option AAS 

 

Office Professional/General Business 
Advisory Board 

 
Special thanks to the members of the 
Office Professional/General Business 
advisory board for their continued advice 
and support. 

 Donna Burchett – Panola County 
Second Assistant County Auditor 

 Jeannie Foster – Express Employment 
Professionals, Longview 

 Dr. Betty Johnson – General Business 
Professor, Stephen F. Austin State 
University, Nacogdoches 

 Paul Patel – Vice President, Holiday Inn 
Express & Suites, Carthage 

 Donna Porter – Assistant 
Superintendent, Carthage Independent 
School District, Carthage 

 Pamela Roberts – Texas Department of 
Aging and Disability Services, 
Nacogdoches 

 Bryan Tarjick – Business Education 
Teacher/Tech Support, Panola Charter 
School, Carthage 

 Moriah Thelen – Administrative 
Assistant, Texas Eastman, Longview 

 Dr. Charles Williams – Chair of the Fred 
Hale School of Business, East Texas 
Baptist University 

Office Professional/General Business 
Degrees and Certificates 

 
Associate of Applied Science Degrees: 

 Office Professional 

 Office Professional (Medical Option)  

 General Business 

Certificates: 

 Administrative Assistant 

 Medical Office Management 

 General Office 

 General Business 

 Marketable Skills 

Office Professional/General Business 
Contact Information 

 
Mailing address: 

Office Professional Program 
Panola College 
1109 W. Panola 
Carthage, TX 75633 

Program Advisor: 
Dwayne Ferguson 
(903) 693-2066 
dferguson@panola.edu 

Join FBLA Today!  

Future Business Leaders of 
America (FBLA) is the largest 
business student organization in 
the world! A quarter of a million 
high school and middle school 
students, college and university 
students, faculty, educators, 
administrators, and business 
professionals have chosen to be members of the premier business education 
association preparing students for careers in business. And now, the Phi Beta 
Lambda (PBL) chapter on the Panola College campus is recruiting new members. 
If you are interested in developing leadership, communication, and team skills, or 
simply looking for an organization to meet and network with others at the local, 
state and national levels, then FBLA-PBL is the organization for you. Contact 
Jo Ellen Gates at (903) 693-1164 or jgates@panola.edu for more information. 

Find Us on the Web 

Keep up with us on the Web by using the information below: 

 Office Professional program Web page 
 http://www.panola.edu/users/dferguson/op/ 

 General Business program Web page 
 http://www.panola.edu/users/dferguson/gb/ 

 Office Professional/General Business blog 
 http://officeprofessionalpc.wordpress.com 
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Panola College is accredited by the Commission on Colleges of the Southern Association of Colleges and Schools to award Associate degrees and certificates of completion. 

Contact the Commission on Colleges at 1866 Southern Lane, Decatur, Georgia 30033-4097 or call (404) 679-4500 for questions about the accreditation of Panola College. 
Panola College is an Equal Opportunity Institution that provides educational and employment opportunities on the basis of merit and without discrimination because of race, 
color, religion, sex, age, national origin, veteran status, or disability. 

 


